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4 Imation Matchprint™ Professional Server Quick Start

Starting the Software
Note: The Imation Matchprint™ Professional Server software 

comes loaded on your server.

1) Double-click the Imation Matchprint™ Professional Server software icon located on 
the desktop screen.

2) The Imation Matchprint™ Professional Server main application window appears.

Delete Printer
Note: All of the following operations are done in the Imation 

Matchprint™ Professional Server software.

Delete the Xerox® DocuColor 12™ if initially set up by the installation technician. Skip this procedure if
no printer is present in the dropdown menu.

1) From the Printer menu, select the printer to be deleted.

2) Select the Delete button.

Printer Setup
To add a printer or changes printer settings, complete the following steps:

1) From the Printer menu, select Add Printer. See Figure2.
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[ Figure 1 ]
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5Imation Matchprint™ Professional Server Quick Start

The Printer Settings window displays:

2) Confirm the desired Media Settings for each tray.

The contents of each tray will vary. An example tray setup is as follows:

Contents of: Tray 1  Media Type: Normal Bond  Media Size: Letter (8.5" x 11")

Contents of: Tray 2  Media Type: Normal Bond  Media Size: Letter Rotated (11" x 8.5")

Contents of: Tray 3  Media Type: Normal Bond  Media Size: Legal (8.5" x 14")

Contents of: Tray 4 Media Type: Normal Bond  Media Size: Tabloid (11" x 17") or Heavyweight (12” x 18”)

Contents of: Tray 6 (High Capacity Feeder) – Optional Media Type: Normal Bond 
Media Size: Letter (8.5" x 11")

Note: Tray 5 is a manual feed tray located on the left side of the Xerox ® DocuColor 12 ™. Load the paper
so the watermark is face down in the tray. (Tray 5 is not configured here.)

[ Figure 2 ]
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6 Imation Matchprint™ Professional Server Quick Start

Printer Calibration
For Color critical customers, Imation recommends daily calibration and recalibration each time the
printer is serviced.

Printer calibration can be performed internally by using the DocuColor 12™ CP built-in scanner or by
using the Spectrocam™, an external measurement device, on the DocuColor 12™ LP. 

Note: Refer to the Imation Matchprint Professional Server on-line User Guide for complete information 
on calibrating with the Spectrocam™.

If calibration is to be performed using the DocuColor 12 scanner, please skip to the section titled,
"Compete the following steps for calibration."

Spectrocam™ Setup

1. Shut down the computer. 

2. Connect the Spectrocam™ to the COM 1 (or appropriate) serial port on the back of the Imation 
Matchprint™ Professional Server. 

3. Plug the Spectrocam power connector into the AC adapter and then plug the AC adapter into a 
power outlet. 

4. Power on the computer. 

5. Launch the Imation Matchprint™ Professional Server software.

Complete the following steps for calibration:

1. From the Printer menu, select XeroxDocuColor 12 (or the name of the printer requiring calibration). 
The Printer Settings window displays.

4
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7Imation Matchprint™ Professional Server Quick Start

2. Click on Calibration to display menu selections Perform Printer   
Calibration and Printer Calibration Setup.

3. Select Printer Calibration Setup to display the following setup screen:

4. Enter how often the printer requires calibration. 

The Last Calibration column displays the time elapsed since a particular media has been calibrated.
Uncalibrated medias display "n/a" in this column. If the time elapsed is longer than the calibration
interval, the "Calibrated?" column will say No.
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8 Imation Matchprint™ Professional Server Quick Start

5. Click OK.

6. From the Calibration menu, select Perform Printer Calibration. The following screen appears:

7. From the Device drop-down list box, choose either the DocuColor 12 Scanner or the Spectrocam
Device.

8. From the Media Type drop-down list box, select the media to be calibrated.

Note: Transparency media cannot be calibrated.

9. From the Media Size drop-down list box, select the media size on which to print the calibration form. 

10. From the Tray drop-down list box, select the input tray containing the specified media.

11. Click on Print Test Form button. A progress bar appears as the form prints:

12. When the form printing is complete:

•  Go to Calibrating with the DocuColor12 Scanner for scanner calibration.   

•  Go to Calibrating with the Spectrocam for Spectrocam calibration. 
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9Imation Matchprint™ Professional Server Quick Start

Calibrating with the DocuColor12 Scanner

1. Place the calibration form on the platen of the DocuColor 12 and click Calibrate.

2. If the calibration is successful, the screen display says, "The calibration process was successful.
You may now calibrate another media."

3. Click OK to go back to the calibration window.

Note:  If the calibration process fails, check to make sure the test page is properly positioned on the platen. 
The scanable area is 11"x 17". If the calibration test form is outside this area, calibration will fail.

Calibrating with the Spectrocam™

1. Place the test form and ruler on the black scanner plate and position the measurement device on
the first patch on the upper, left corner.

2. Click on the Calibrate button.

If the Spectrocam was not previously calibrated, a prompt directs you to calibrate the white reference.
Place the measurement device on the white target reference and touch the green sensor to calibrate.
After calibrating with the white reference, reposition the measurement device on the first patch on the
upper, left corner of the test form.

3. Touch the green sensor and move the device slowly down the first row. When you complete the first
row, reposition the Spectrocam over the first patch of the second row and touch the green sensor
again to begin measuring the second row. Continue in this fashion until all rows are read. 

• Patches are read from left to right in a slow, steady manner. It should take approximately 6 to 8 
seconds to completely scan one row.

• If you move too slowly or too rapidly, patches are not read correctly. Within the calibrate dialog 
an X appears on any patch that is miss-read. 
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10 Imation Matchprint™ Professional Server Quick Start

If the calibration is successful, the following message appears: "The calibration process was
successful. You may now calibrate another media." 

4. Click on OK to return to the calibration window. 
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Adding a Spooler
1. From the Input menu, select Add Spooler. The Spooler Settings window displays. See Figure 4.

Spooler option tabs are Printer, Color, Output, PDF, Preview and Summary.

Note: In a Macintosh environment, a spooler is listed in the chooser  after it is created on the Imation
Matchprint™ Professional Server software.  

2. Enter the Printer Name to which the new Spooler will send jobs. This name is what client users will
see when they select a printer on the network.

Note: When creating a spooler to be used in a mixed Operating System environment, remember that
Windows 95/98 require the spooler name to be 12 characters or less. 
(Alpha-numeric characters and spaces are allowed.)

3. Make sure Active is checked. (The default setting is for Active to be checked.)

4. Click on Printer, Color, Output, PDF, Preview and Summary tabs to enter the Spooler configuration.
When the file enters this Spooler, it is given these default settings.

Note: For PostScript jobs submitted via a Proof File, job parameter settings for Number of Copies,
Input Tray and Media Type override the PostScript file codes. For all other settings, the PostScript
file settings override the job parameter settings.

For PostScript jobs submitted through a spooler or hot folder, the values in the PostScript file
always override the default job parameters for that spooler or hot folder. 

Spooler Options

11Imation Matchprint™ Professional Server Quick Start
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12 Imation Matchprint™ Professional Server Quick Start

Adding a Hot Folder
Hot Folders are folders the Imation Matchprint™ Professional Server software “watches” for
incoming job files. When a recognized file is placed into a Hot Folder, it is automatically entered into
the job queue for proofing.

Important! Files are automatically deleted from a Hot Folder after successfully printing. Do not place
original files into Hot Folders. 
Always “copy” files to a Hot Folder.

1. From the Input menu, select Add Hot Folder. The Hot Folder Settings window displays. See Figure
5. Hot Folder option tabs are Printer, Color, Output, PDF, Preview and Summary.

2. Select the location of the Hot Folder by clicking Browse... You may select an existing folder or
create a new folder. (Create a new folder by navigating to the location where you want the folder. At
the end of the path string type \xxx [where xxx is the new folder name], then click OK. Answer Yes
to the question, “Do you want the folder to be created?”)

Note: Make sure Active is checked. (The default setting is for Active to be checked.)

3. Enter the Poll Interval seconds to set how often this Hot Folder will be checked for jobs. 
(Default =10 seconds)

4. Click on Printer, Color, Output, PDF, Preview and Summary tabs to enter Hot Folder custom
configurations. When the file enters this Hot Folder, it is given these default Hot Folder settings.

Note: For PostScript jobs submitted via a Proof File, job parameter settings for Number of Copies,
Input Tray and Media Type override the PostScript file codes. For all other settings, the PostScript
file settings override the job parameter settings.

For PostScript jobs submitted through a spooler or hot folder, the values in the PostScript file
always override the default job parameters for that spooler or hot folder.

Set up additional hot folders as needed for jobs with different parameters.

6
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13Imation Matchprint™ Professional Server Quick Start

Hot Folder Options

For additional details on the use of the Imation Matchprint™ Professional 
Server, see the ON-LINE HELP, located under the Help menu selection.i

[ Figure 5 ]
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14 Imation Matchprint™ Professional Server Quick Start

Setting Preferences
Select Preferences from the File menu. The File Preferences dialog box displays. See Figure 6.

The Preferences dialog contains three tabs: General, Cache, and Paths.

General Tab

7

[ Figure 6 ]

The General tab allows you to customize how sizes are displayed in the File Information and Job
Parameters subsets, and to customize the Job Slug Options.

Display Units allows you to set inches, centimeters, or pixels. This setting customizes how sizes are
displayed in the File Information and Job Parameter subsets.

Job Slug Options allows you to selectively display document name, user name, media type, color
target, date and time, printer name and job ID. The Job Slug is an optional block of information that 
can be added to your proofs.

Download from Www.Somanuals.com. All Manuals Search And Download.



15Imation Matchprint™ Professional Server Quick Start

Cache Tab

The Cache tab allows you to customize how spooled or RIP’ed job files are saved. Files can be purged
based on age, total size, or both.

• Select Keep Spooled Job Files to retain spooled jobs. De-selecting Keep Spooled Job Files
does not purge pre-existing job files.

• Enter the number of days and/or megabytes the Spooled Job files should be saved. (The
default is 14 days or when 2000 MB is exceeded.) When the size limit is exceeded, the
fewest possible files (oldest first) are deleted.

• Enter the number of days and/or megabytes the RIP’ed Job files should be saved. (The
default is 14 days or when 2000 MB is exceeded.) When the size limit is exceeded, the
fewest possible files (oldest first) are deleted.

[ Figure 7 ]

For additional details on the use of the Imation Matchprint™ Professional 
Server, see the ON-LINE HELP, located under the Help menu selection.i
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16 Imation Matchprint™ Professional Server Quick Start

Paths Tab

The Paths tab allows you to customize the location of where the server will save RIP’ed, spooled and
temporary files. The folder setting for each of the file categories is listed.

To change a folder setting, select the appropriate Browse... button of the folder you wish to change. A
Choose Folder dialog box is displayed. Select the desired folder. The Preferences dialog box 
is updated to reflect your selection.

Note: 1) Changes to the Saved Jobs, Temp Files, or RIP’ed Pages folder take effect immediately,
although jobs currently processing will not be affected. (Note that PostScript™ temp files are
not stored in the Temp Files folder.)

2) The Imation Matchprint™ Professional Server has a second drive labeled D:/. It is
recommended to use this drive for spooled and RIP’ed file storage.

[ Figure 8 ]
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17Imation Matchprint™ Professional Server Quick Start

Installing PPDs 
on Client Machines

Once the software is installed, Postscript™ Printer Driver (PPD) installation may be necessary to allow
client Macintosh® or PC computers to properly print to the Xerox® DocuColor 12™ copier over the network.
Client workstations can be Windows NT®, Windows® 2000, Windows® 95/98, or Macintosh® systems.

The Imation Matchprint Professional Server software includes the latest version of the AdobePS driver.
Microsoft® Windows client machines wishing to print to the Imation Matchprint Professional Server
automatically install the AdobePS driver when the printer is added via the Windows "Add Printer" dialog.

Macintosh® client machines must install the driver and PPD from either the Imation Matchprint
Professional Server CD-ROM or from the Imation server itself. Macintosh® users must first run Stuffit
Expander to unstuff the Mac-Doc12-PPD-Installer.bin before launching the Imation PPD and AdobePS driver.

Depending on your client workstation setup, select the appropriate PPD installation from the following:

Windows NT® or Windows 2000® Client PPD Installation

Window® 95/98 Client PPD Installation

Macintosh® Client PPD Installation

Windows NT® or
Windows 2000 Client PPD

Two modes of imageable print areas are supported by the Imation Matchprint™ Professional Server
system, expanded and normal. On initial setup, clients adding printers will automatically capture the
current mode associated with the IMPS system. After the initial setup, if the IMPS server administrator
switches the imageable print area, clients will need to delete existing IMPS client printers and add new
ones. Adding new printers will reflect the new print area mode.

Steps 1-11 are instructions to add a printer on initial Imation Matchprint™ Professional Server
system setup. Steps 12-18 provide instructions for re-adding a printer once the imageable print area
has been changed.

1. At the Imation Matchprint™ Professional Server, set up the print spooler where the client machine
will print.

Continued on next page
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18 Imation Matchprint™ Professional Server Quick Start

Note: When creating a spooler to be used in a mixed Operating System environment, remember that 
Windows® 95/98 require the spooler name to be 12 characters or less (alpha-numeric 
characters and spaces are allowed).

2. At the client Windows machine, either log into the same domain as the Imation Matchprint™
Professional Server, or connect to the Imation Matchprint™ Server with a valid user name and
password that has a minimum of read access. For security purposes, Imation does NOT recommend
enabling the Guest Account.

Failure to do so will result in Windows 2000 clients receiving the following error message when
trying to print an image: "Could not complete the print command because the selected printer
driver could not be found. Please select a printer from the control panel and try again."

Workgroup Environment Considerations: In a Workgroup environment, the Imation Matchprint™
Professional Server must be a member of the same workgroup as the client workstations.

3. At the Start button, select Settings, then Printers.

4. Double-click on Add Printer.

5. With the Network printer server selected, click on Next.

6. Using the Add Printer Wizard, browse to the location of the RIP print server and select the spooler
created in step 1.

7. Click OK.

8. Select Yes to have this printer set as your default printer. Click Next. A message appears saying
the printer has been successfully installed.

9. Click on Finish. The printer is now added to your system.

10. Using the Windows client design application, choose Page Setup. Click Printer and select the
spooler name as created in step 1. Note that the Printer Where location reflects the RIP's spooler
pathname. Click OK.

11. Click OK to close the Page Setup dialog box. You are now ready to print.

Note: Some design applications require the print spooler to be selected as the default printer. Failure 
to select the Matchprint™ Professional Server as the default printer may not allow your design 
application to print to the Xerox® DocuColor 12™. The following type of error might appear, 
"Could not complete the Page Setup command because the selected printer driver could not be 
found. Please select a printer from the control panel and try again."

If you get this type of error, change the default printer in your Printer Control Panel. Click on 
Start>Settings>Printers. Click once on the Matchprint™ Professional Server print spooler name 
and click File - Set as Default. Launch your design application, open the file to print, and either 
select to print or choose Page Setup and select the Matchprint™ Professional Server print spooler.
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Re-adding Printers for Imageble Area

12. Restart the client system.

13. Delete all printers from the client.

14. Delete all files and folders within winnt\system32\spool\drivers\w32x86.

15. At the Imation Matchprint™ Professional Server, install the selected image area. (This is located 
in c:\Program Files\Imation\Imation Matchprint Professional Server\Print Area Setups.)

16. At the Xerox DocuColor 12, install the selected image area. (See Xerox DocuColor 12 User’s Guide.)

17. Restart both the client and Imation Matchprint™ Professional Server systems.

18. Add the new printer at the client. (See steps 1-11 of this procedure.)

Note: When adding the printer after changing the image area setting, it may takeup to 15 minutes for 
it to show up on the system.

Windows® 95/98 Client PPD

Two modes of imageable print areas are supported by the Imation Matchprint™ Professional Server
system, expanded and normal. On initial setup, clients adding printers will automatically capture the
current mode associated with the IMPS system. After the initial setup, if the IMPS server
administrator switches the imageable print area, clients will need to delete existing IMPS client
printers and add new ones. Adding new printers will reflect the new print area mode. 

Steps 1-15 are instructions to add a printer on initial Imation Matchprint™ Professional Server
system setup. Steps 16-22 provide instructions for re-adding a printer once the imageable print area
has been changed.

1. At the Imation Matchprint™ Professional Server, set up the print spooler where the client
machine will print. Keep spooler names to 12 characters or less. Windows® 95/98 require the
Spooler name be 12 characters or less. (Alpha-numeric characters and spaces are allowed).

2. At the client Windows® 95/98 machine, log into the same domain as the Imation Matchprint™
Professional Server.

19Imation Matchprint™ Professional Server Quick Start

For additional details on the use of the Imation Matchprint™ Professional 
Server, see the ON-LINE HELP, located under the Help menu selection.i
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20 Imation Matchprint™ Professional Server Quick Start

Note: If when trying to add a printer, the Imation server requests a password, but does not allow the 
user to log in as a guest, the Imation server administrator must set the User Manager for 
Domains Guest properties to a blank password and check Password Never Expires. This allows 
the Windows® 95/98 client workstation to add the Imation spooler as a printer.

Workgroup Environment Considerations: In a Workgroup environment, the Imation Matchprint™
Professional Server must be a member of the same workgroup as the client workstations.

3. At the Start button, select Settings, then Printers.

4. Click on Add Printer.

5. Click on Next.

6. Select Network printer.

7. Click on Next.

8. Browse to the location of the Imation Matchprint™ Professional Server and select the spooler
created in step 1.

9. Under the text, "Do you print from MS-DOS based programs?," leave No selected.

10. Click on Next.

11. Edit the printer name, if desired. A default printer name based on the printer driver is
automatically entered. However, you can type in a more descriptive name. The name you type only
appears on this Window® 95/98 client workstation.

12. Click on Next.

13. A dialog box appears asking if you want to print a test page. If you select Yes, another dialog box
appears asking if it printed successfully. If it did print successfully or you answered No to print a
test page, drivers are copied and a window appears showing the added printer.

14. Using the Windows® 95/98 client design application, choose Page Setup. Click Printer and select
Xerox® DocuColor 12™. Note that the Printer Where location reflects the RIP's spooler
pathname. Click OK.

15. Click OK to close the Page Setup dialog box. You are now ready to print.

Re-adding Printers for Imageable Area

16. Restart the client system.

17. Delete all printers from the client.

18. Delete the Imxdoc12 PPD file within windows\system.

19. At the Imation Matchprint™ Professional Server, install the selected image area. (This is located
in c:\Program Files\Imation\Imation Matchprint Professional Server\Print Area Setups.)
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20. At the Xerox DocuColor 12, install the selected image area. (See Xerox DocuColor 12 User’s Guide.)

21. Restart both the client and Imation Matchprint™ Professional Server systems.

22. Add the new printer at the client. (See steps 1-15 of this procedure.)

Note: When adding the printer after changing the image area setting, it may take up to 15 minutes for 
it to show up on the system.

Macintosh® Client PPD

The Macintosh® client PPD is available to download using the Imation Matchprint™ Professional
Server CD-ROM, from the Imation Matchprint™ Professional Server Web User Interface (UI), and
directly from the Imation Matchprint™ Professional Server.

Loading PPD from CD-ROM

1. Determine which mode of Printer Image Area (Normal or Expanded) the Imation Matchprint™
Professional Server is operating.

2. It is recommended that any virus protection software be disabled before you use the Mac-Doc12-
PPD-Installer.

3. Insert the Imation Matchprint™ Professional Server CD-ROM. An icon for the CD-ROM appears on
your desktop.

4. Double-click on the CD icon.

5. View the two folders, Expanded and Normal, in the displayed window.

Double-click on the appropriate folder to view the Mac-Doc12-PPD-Installer and Install Imation PPD
Readme files.

21Imation Matchprint™ Professional Server Quick Start
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22 Imation Matchprint™ Professional Server Quick Start

6. Double-click on the Mac-Doc12-PPD-Installer. The associated Readme dialog displays. Select the
Continue button. The following dialog displays.

Select the Install button to install the Imation PPD for the Xerox DocuColor12. When PPD
installation is complete, the following dialog displays:

Download from Www.Somanuals.com. All Manuals Search And Download.



23Imation Matchprint™ Professional Server Quick Start

7. Imation recommends using the AdobePS printer drivers. Click on Yes if you wish to do so. The
following dialog appears:

Select OK and the following dialog displays:

8. Click on Quit. The AdobePS installer screen appears. Select Continue to begin the installation of the
AdobePS drivers.
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24 Imation Matchprint™ Professional Server Quick Start

A new installer window opens displaying the AdobePS Installer:

9. Click on Install. When installation is complete, the following dialog appears:

10. Click on Quit, if you are done installing.

Downloading from the Web User Interface 

1. Determine which mode of Printer Image Area (Normal or Expanded) the Imation Matchprint™
Professional Server is operating.

2. Access the Imation Matchprint™ Professional Server Web User Interface using a web browser.

3. Click on the Download Mac PPD Installer link in the left frame of the window.

Note: This is a compressed file. If your web browser is not configured to automatically decompress 
files, locate the downloaded file Mac-Doc12-PPD-Installer.bin and use a decompression 
application similar to Stuffit Expander™ to decompress the file.

4. Continue with step 6 in the Loading from CD-ROM procedure.
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25Imation Matchprint™ Professional Server Quick Start

Loading from the Imation Matchprint™ Professional Server

1. Determine which mode of Printer Image Area (Normal or Expanded) the Imation Matchprint™
Professional Server is operating.

2. Have the Imation Matchprint Professional Server administrator create a Mac Share for the folder
c:\Program Files\Imation\Imation Matchprint Professional Server\MAC PPD.

3. At the Macintosh client, navigate to the Imation Matchprint Professional Server and then to the
c:\Program Files\Imation\Imation Matchprint Professional Server\MAC PPD.

4. Copy the MAC PPD folder to your Macintosh computer.

5. Follow step 5 in the Loading from CD-ROM procedure.

Macintosh® Client Setup

1. At the Imation Matchprint™ Professional Server, set up the print spooler where the client machine
will print. Go to Adding a Spooler located under Getting Started for additional information.

2. In the Chooser, click on the Adobe PS printer icon in the left column. This displays a list of
compatible PostScript printers in the right side of the window.

3. Double-click on the desired spooler.

A set up window appears and the Chooser tries to locate the correct PPD from the PPD folder.
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26 Imation Matchprint™ Professional Server Quick Start

If the Chooser cannot determine which PPD file to use, or if the Select PPD Button is clicked on,
another window opens and you are prompted to select a PostScript™ Printer Description file from the
PPD folder.

4. Click on the DocuColor12 (Imation) PPD and then click on the Select button.

A set up window appears showing, "Status: selecting the printer description files."

Once the PPD is selected, another dialog opens and prompts you to set the installable options.
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27Imation Matchprint™ Professional Server Quick Start

5. Choose the options from the drop-down menus appropriate for your configuration. Click on the OK
button when finished. A final status window appears showing, "Building Desktop Printer."

When complete, an icon for the selected printer appears on your desktop.

Recommendations
1. Imation recommends using AdobePS when printing from Macintosh workstations.

2. Put the software that comes packaged with your system in a safe place.

3. For additional details on the use of the Imation Matchprint™ Professional Server, see the on-line
help, located under the Help menu selection.
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